
ACCOUNTANCY
Code No. 055

SAMPLE QUESTION PAPER — SET 3  |  CLASS XII

Time Allowed: 3 Hours                                                                    Maximum Marks: 80

General Instructions:

1. This question paper contains 34 questions. All questions are compulsory.

2. This question paper is divided into two parts, Part A and Part B.

3. Part A is compulsory for all candidates.

4. Part B has two options: (i) Analysis of Financial Statements and (ii) Computerised Accounting. Students must attempt 
only ONE of the given options.

5. Questions 1 to 16 and 27 to 30 carry 1 mark each.

6. Questions 17 to 20, 31 and 32 carry 3 marks each.

7. Questions 21, 22 and 33 carry 4 marks each.

8. Questions 23 to 26 and 34 carry 6 marks each.

9. There is no overall choice. However, an internal choice has been provided in 7 questions of one mark, 2 questions of 
three marks, 1 question of four marks and 2 questions of six marks.

PART A

Accounting for Partnership Firms and Companies (Compulsory for all candidates)

1. A partner's Capital Account was credited with 25,000 during the year under the fluctuating capital ₹
method. Which of the following could explain this credit?

(A) Drawings

(B) Share of loss

(C) Salary credited

(D) Interest on partner's loan

OR

Assertion (A): The Fluctuating Capital Method does not require a separate Current Account.

Reason (R): All adjustments are recorded directly in the single Capital Account under this method.

(A) Both A and R are correct and R is the correct explanation of A.

(B) Both A and R are correct but R is not the correct explanation of A.

(C) A is correct but R is incorrect.

(D) Both A and R are incorrect.

1

2. P, Q and R share profits 3:2:1. R was guaranteed a minimum profit of 60,000 p.a.; deficiency, if ₹
any, to be borne by P and Q in the ratio 3:2. Firm profit for the year was 2,40,000. The deficiency ₹
borne by P and Q will be:

(A) P 12,000 and Q 8,000₹ ₹

(B) P 10,000 and Q 10,000₹ ₹

(C) P 15,000 and Q 5,000₹ ₹

(D) No deficiency arises

1



3. Solaris Ltd. issued 60,000 shares of 10 each at a premium of 4, payable 7 on application (incl. ₹ ₹ ₹
2 premium), 5 on allotment (incl. 2 premium), balance on call. Diya, holding 1,200 shares, ₹ ₹ ₹

failed to pay allotment and was immediately forfeited. All 1,200 forfeited shares were reissued at 
13 per share, fully paid. Determine the Capital Reserve transferred.₹

(A) 6,000    (B) 9,600    (C) 2,400    (D) 4,000₹ ₹ ₹ ₹

OR

Vertex Ltd. forfeited 12,000 shares of 10 each, 8 called up (including 3 premium), on which 6 ₹ ₹ ₹ ₹
(including 3 premium) had been received. Of these, 9,000 were reissued at 7 per share, 10 paid-₹ ₹ ₹
up. Determine the Share Forfeited balance after reissue.

(A) 9,000    (B) 36,000    (C) 27,000    (D) Nil₹ ₹ ₹

1

4. Crest Ltd. took over the running business of Ridge Ltd. comprising assets of 35,00,000 and ₹
liabilities of 8,00,000, and in consideration issued 18,000 equity shares of 100 each at a 5% ₹ ₹
premium, plus a cheque of 6,00,000. Determine the amount of Goodwill or Capital Reserve.₹

(A) Capital Reserve 2,10,000    (B) Goodwill 2,10,000    (C) Capital Reserve 1,50,000    (D) ₹ ₹ ₹
Goodwill 1,50,000₹

OR

North Ltd. purchased furniture, paying 1,80,000 by cheque and issuing 8,000 equity shares of 10 ₹ ₹
each at a 10% premium. The purchase consideration will be:

(A) 2,68,000    (B) 2,80,000    (C) 2,60,000    (D) 1,80,000₹ ₹ ₹ ₹

1

5. Arjun and Dev were partners with capitals of 15,00,000 and 10,00,000. They admitted Esha for a ₹ ₹
1/3 share; she brought 10,00,000 as capital. An Investment Fluctuation Reserve of 50,000 and ₹ ₹
Investments of 2,50,000 appeared in the books. Arjun took over 30% of the investments at ₹

60,000, and the remaining investments were valued at 2,00,000. By what amount will the ₹ ₹
Revaluation Account be affected?

(A) Credited 10,000₹

(B) Debited 10,000₹

(C) Credited 25,000₹

(D) Debited 15,000₹

1

6. Aarav and Vivaan are partners sharing profits 3:2. Their capitals are 4,00,000 and 2,00,000, with ₹ ₹
reserves of 1,00,000. Normal rate of return is 10%. Average profit for the year was 90,000. Value ₹ ₹
of goodwill as per the Capitalisation of Super Profits method will be:

(A) 2,00,000₹

(B) 7,00,000₹

(C) 70,000₹

(D) Nil

1

7. On 1 October, 2024, Kabir, Lavanya and Manav entered partnership with capitals of 3,00,000 each.₹  
Interest on drawings was to be charged @6% p.a. For the year ended March 31, 2025, Manav 
withdrew 60,000 on 1 October, 2024. What interest on drawings will be charged from Manav?₹

(A) 1,800₹

(B) 3,600₹

(C) 900₹

1



(D) 2,400₹

8. X, Y and Z were partners sharing profits 5:4:1. Y died. X took over 1/10th (of the whole firm) from 
Y's share, and Z took over the remainder of Y's share. Determine the new profit-sharing ratio.

(A) 3:2    (B) 6:4    (C) 7:3    (D) 5:5

OR

A, B and C were partners sharing profits 3:2:1. B retired, gifting 1/4 of his share to A, while the 
remaining 3/4 was taken over equally by A and C. Determine the new profit-sharing ratio.

(A) 17:7    (B) 3:1    (C) 7:5    (D) 5:3

1

9. P, a partner, was assigned to look after the dissolution process and was allowed remuneration of 
8,000. Actual realisation expenses amounted to 11,000, paid by another partner Q. By what ₹ ₹

amount will the Realisation Account be debited?

(A) 11,000₹

(B) 19,000₹

(C) 3,000₹

(D) 8,000₹

1

10. Aman and Baljit share profits 3:2. They admitted Chetan for a 25% share; Chetan brought 
proportionate capital, including 50,000 for goodwill. If Aman's adjusted capital was 7,50,000, ₹ ₹
Baljit's adjusted capital will be:

(A) 5,00,000    (B) 3,00,000    (C) 10,00,000    (D) 5,50,000₹ ₹ ₹ ₹

OR

Disha and Esha are partners sharing profits 3:2. Their capitals are 4,00,000 and 2,00,000. A ₹ ₹
General Reserve of 2,50,000 and Deferred Revenue Expenditure of 1,50,000 appear in the books. ₹ ₹
They admit Farah for a 20% share; she brings 2,50,000 as capital. Determine Farah's share of ₹
(hidden) goodwill.

(A) 60,000    (B) 30,000    (C) 40,000    (D) 50,000₹ ₹ ₹ ₹

1

11. Furniture appearing in the books at 12,00,000 was overvalued by 20%. What amount will be shown₹  
in the Balance Sheet of the reconstituted firm?

(A) 10,00,000₹

(B) 14,40,000₹

(C) 9,60,000₹

(D) 11,00,000₹

1

12. Pinnacle Ltd. issued 35,000, 8% Debentures of 100 each at a 5% discount, redeemable at a 6% ₹
premium after 5 years. On the date of issue, the Securities Premium balance was 3,00,000 and ₹
Statement of Profit and Loss (Dr.) was 1,50,000. Based on this, answer questions 12 to 14.₹

Loss on Issue of Debentures is to be written off as ______ out of Securities Premium and ______ out 
of Statement of Profit and Loss.

(A) 3,00,000 ; 85,000    (B) 2,10,000 ; 1,75,000    (C) 1,75,000 ; 2,10,000    (D) 3,85,000 ;₹ ₹ ₹ ₹ ₹ ₹ ₹  
Nil

1

13. After writing off the Loss on Issue of Debentures, the balance in the Statement of Profit and Loss 
will be:

1



(A) Debit ; 2,35,000    (B) Credit ; 2,35,000    (C) Debit ; 1,50,000    (D) Credit ; 1,50,000₹ ₹ ₹ ₹

14. Premium on Redemption of Debentures Account will have a balance of ______, to be treated as 
______ in the first year.

(A) 2,10,000 ; Non-Current Liability    (B) 2,10,000 ; Current Liability    (C) 1,75,000 ; Non-₹ ₹ ₹
Current Liability    (D) 1,75,000 ; Current Liability₹

1

15. G, H and I were partners sharing profits 3:2:1. Their firm was dissolved. Assets transferred to 
Realisation Account (Building 1,60,000; Furniture 50,000; Stock 45,000; Goodwill 10,000; ₹ ₹ ₹ ₹
Debtors 35,000) realised 2,70,000 in total. Determine the Realisation Gain/Loss.₹ ₹

(A) Realisation Loss 30,000₹

(B) Realisation Gain 30,000₹

(C) Realisation Loss 20,000₹

(D) No Gain or Loss on Realisation

1

16. Simran and Tanvi were equal partners. They decided to share future profits 2:1. Their manager U 
met with an accident, and his claim for compensation amounted to 30,000. The firm had a ₹
Workmen Compensation Reserve of 45,000. Which of the following holds true?₹

(A) 30,000 will be provided as a claim, and the balance 15,000 distributed among partners in the ₹ ₹
OLD (equal) ratio.

(B) 30,000 will be provided, and the balance 15,000 distributed in the NEW ratio.₹ ₹

(C) 30,000 will be provided, and the balance 15,000 credited to Revaluation Account.₹ ₹

(D) 30,000 will be provided, and the balance 15,000 carried forward without treatment.₹ ₹

1

17. Aarav and Bhumika are partners sharing profits 3:2. They admit Chandan for a 1/4 share. It is agreed 
that Bhumika's new share will be 3/10. Goodwill of the firm is valued at 1,60,000, and Chandan is ₹
unable to bring his share of goodwill in cash. Calculate the new ratio, sacrificing ratio, and pass the 
journal entry for the treatment of goodwill at the time of admission of Chandan.

OR

Ishaan, Jatin and Kunal were partners sharing profits 3:2:1. W.e.f. 1 April, 2025, they decided to 
share future profits in the ratio 2:2:1. On the date of reconstitution, Goodwill was appearing in the 
books at 1,20,000. Goodwill of the firm was valued at 1,80,000 on the date of reconstitution. ₹ ₹
Determine the gain or sacrifice of each partner, and pass the necessary journal entries.

3

18. Rohan and Samin were partners sharing profits 3:2. The firm was dissolved, and the following 
balances appeared: Rohan's Loan 40,000; a third-party Loan 25,000; Creditors 60,000; Capital ₹ ₹ ₹
balances after all adjustments — Rohan 90,000 and Samin 80,000. Assets of the firm realised at ₹ ₹

3,20,000. Show the amounts and order of payment as per Section 48 of the Indian Partnership Act, ₹
1932.

3

19. On 1 January, 2025, Zenith Ltd. issued 15,00,000, 8% Debentures of 100 each at a 5% discount, ₹ ₹
to be redeemed at a 6% premium after 5 years. The balance in Securities Premium on the date of 
issue was 1,00,000. Pass journal entries for the issue of debentures.₹

3

20. Riya and Samin are partners sharing profits 3:2. They decide to share future profits equally. On the 
date of reconstitution, an Investment Fluctuation Reserve of 2,00,000 existed in the books. Pass ₹
journal entries in each of the following independent cases:

A. Value of investments is reduced by 1,20,000.₹

3



B. Value of investments is increased by 2,50,000.₹

C. There is no change in the value of investments.

21. Pearl Ltd. was registered with an authorised capital of 40,00,000 divided into 2,00,000 shares of ₹
20 each. The company offered and issued 90,000 shares at a premium of 5 per share, payable 8 ₹ ₹ ₹

on application (incl. 1 premium), 11 on allotment (incl. 2 premium), and the balance on first ₹ ₹ ₹
call. Tanvi, holding 5,000 shares, failed to pay allotment and call money. Another shareholder, 
Vivek, holding 2,500 shares, failed to pay call money. All shares held by Tanvi were forfeited, and 
of these, 3,500 were reissued at 16 per share as fully paid. Show the Share Capital sub-head as it ₹
would appear in the Balance Sheet of Pearl Ltd., along with Notes to Accounts, as per the 
Companies Act, 2013.

4

22. Ishani, Jaya and Karan are partners sharing profits 5:3:2. Their capitals are 5,00,000, 4,00,000 and₹ ₹  
3,00,000 respectively. As per the Partnership Deed:₹

(a) Interest on Capital @10% p.a.

(b) Salary to Ishani 5,000 p.m. and Karan 9,000 per quarter.₹ ₹

(c) Commission to Jaya 40,000.₹

(d) Jaya is guaranteed a minimum profit share of 42,000; deficiency, if any, to be borne by Ishani ₹
and Karan equally.

Ignoring the above terms, the profits of 3,50,000 for the year ended March 31, 2025 were divided ₹
equally between the partners. Pass the necessary single adjustment entry, showing your workings 
clearly.

4

23. Northstar Ltd. purchased the running business of South Peak Ltd., comprising assets of 28,00,000 ₹
and liabilities of 10,00,000, and issued fully paid Equity Shares of 100 each at a premium of 20% ₹ ₹
in full settlement. During the same year, Northstar Ltd. also issued 20,000 additional Equity Shares 
of 100 each at a premium of 10 per share for cash, fully subscribed and paid.₹ ₹

Pass journal entries for both transactions, and prepare the Share Capital Account and Securities 
Premium Account. (Assume an opening Share Capital balance of 90,00,000 and an opening ₹
Securities Premium balance of 4,00,000.)₹

6

24. Devika, Eshan and Farhan were partners sharing profits 5:3:2. Eshan retired on March 31, 2025. On 
this date, his dues after all adjustments came to 4,20,000. He was paid 30,000 through Furniture ₹ ₹
on retirement, and it was agreed to pay the balance in three equal annual instalments together with 
interest at 6% p.a. (the default rate under the Act), the first instalment being paid on March 31, 2026. 
Pass the entry for immediate payment to Eshan on retirement, and prepare Eshan's Loan Account 
until it is finally closed.

6

25. Aarav and Bhavya were partners sharing profits 3:2. Their Balance Sheet as at March 31, 2025 was: 
Capitals — Aarav 2,00,000, Bhavya 1,50,000; Creditors 60,000; total 4,10,000. Assets: Cash ₹ ₹ ₹ ₹

25,000; Building 1,80,000; Debtors (net) 75,000; Investments 60,000; Stock 70,000; total ₹ ₹ ₹ ₹ ₹
4,10,000.₹

On this date, they admitted Chirag for a 20% share. Chirag brought 1,50,000 as capital and ₹
25,000 for goodwill. It was agreed: a) Provision for Doubtful Debts to be increased by 4,000. b) ₹ ₹

Investments (book value 60,000) valued at 50,000. c) Building (book value 1,80,000) ₹ ₹ ₹
appreciated by 10%. Prepare the Revaluation Account and Partners' Capital Accounts.

OR

Manav, Naina and Omar were partners sharing profits 5:3:2. Their Balance Sheet as at March 31, 
2025 showed: Capitals — Manav 1,00,000, Naina 80,000, Omar 60,000; Creditors 45,000; ₹ ₹ ₹ ₹
total 2,85,000. Assets: Cash 30,000; Building 1,10,000; Debtors 60,000; Stock 55,000; ₹ ₹ ₹ ₹ ₹

6



Goodwill 30,000; total 2,85,000. On this date, Naina retired. It was agreed: (a) Provision for ₹ ₹
Doubtful Debts @10% on Debtors. (b) Building valued at 1,30,000. (c) Goodwill of the firm ₹
valued at 60,000. Prepare the Revaluation Account and Partners' Capital Accounts.₹

26. Crystal Ltd. was registered with an authorised capital of 10,00,000 divided into 1,00,000 shares of ₹
10 each. The company offered 40,000 shares for public subscription, payable 3 on application and₹ ₹  
5 on allotment (including 1 premium). Applications were received for 50,000 shares, and pro-rata ₹ ₹

allotment was made in the ratio 5:4. Remaining applications were rejected. Simran, who applied for 
5,000 shares (allotted 4,000), failed to pay the allotment money on her allotted shares, which were 
duly forfeited. Of these, 3,000 shares were later reissued at a discount of 1.20 per share, fully paid.₹

Pass the necessary entries in the books of Crystal Ltd.

OR

Beacon Ltd. invited applications for 1,20,000 shares of 10 each, payable 3 on application, 4 on ₹ ₹ ₹
allotment (including 1 premium), balance on call. Applications were received for 1,80,000 shares, ₹
of which 20% were rejected, and the remaining were allotted on a pro-rata basis. Nakul, an applicant 
for 7,200 shares, failed to pay allotment money. Onika, holding 4,800 shares, paid the entire amount 
due along with allotment. Subsequently the call was made; all money was duly received except from 
Nakul. The company issued a notice to Nakul; he cleared his dues within the stipulated period. 
Journalise these transactions.

6

PART B — OPTION I

Analysis of Financial Statements (Attempt Part B Option I OR Option II, not both)

27. A company had the following balances:

Raw Material: 28,000 (2025), 22,000 (2024). Work in Progress: 75,000 (2025), 95,000 (2024).₹ ₹ ₹ ₹  
Finished Goods: 55,000 (2025), 70,000 (2024). Stock in Trade: 1,40,000 (2025), 1,05,000 ₹ ₹ ₹ ₹
(2024).

Determine the amount of Change in Inventories to be shown in the Statement of Profit and Loss.

(A) 6,000    (B) (6,000)    (C) 16,000    (D) (16,000)₹ ₹ ₹ ₹

1

28. The Inventory Turnover Ratio of a company was 6 times. The firm had a Revenue from Operations 
of 9,00,000, and Gross Profit was 25% of Revenue from Operations. Determine the amount of ₹
Opening Inventory if Closing Inventory was 1,00,000.₹

(A) 1,25,000    (B) 1,00,000    (C) 2,25,000    (D) 75,000₹ ₹ ₹ ₹

OR

Assertion (A): The Current Ratio is always more reliable than the Quick Ratio for assessing short-
term liquidity.

Reason (R): The Quick Ratio excludes inventory and prepaid expenses, which may not be easily 
convertible to cash quickly.

(A) Both A and R are correct and R is the correct explanation of A.

(B) Both A and R are correct but R is not the correct explanation of A.

(C) A is correct but R is incorrect.

(D) A is incorrect but R is correct.

1

29. Proposed Dividend for the years ended March 31, 2025 and March 31, 2024 were 2,20,000 and ₹
1,80,000 respectively. Shareholders finalised the dividend amount at 1,60,000 during the year ₹ ₹

1



ended March 31, 2025 in the AGM held in June-July 2024. Unclaimed dividend as at March 31, 
2025 was 7,000. Choose the correct option while preparing the Cash Flow Statement:₹

(A) Added back 1,80,000; outflow 1,53,000    (B) Added back 2,20,000; outflow 1,53,000    ₹ ₹ ₹ ₹
(C) Added back 1,60,000; outflow 1,53,000    (D) Added back 2,20,000; outflow 1,60,000₹ ₹ ₹ ₹

OR

Provision for Tax for the years ended March 31, 2025 and March 31, 2024 were 2,40,000 and ₹
2,00,000 respectively. During the year, tax paid was 1,90,000. Determine the amount of tax ₹ ₹

provided during the year.

(A) 2,40,000    (B) 2,30,000    (C) 2,00,000    (D) 2,50,000₹ ₹ ₹ ₹

30. Which of the following is a cash flow from Operating Activities for a finance company (whose core 
business involves lending and investing)?

(A) Purchase of a fixed asset

(B) Interest paid on a term loan

(C) Dividend paid to shareholders

(D) Interest and dividend received on loans and investments

1

31. Complete the following Comparative Balance Sheet as at March 31, 2024 and March 31, 2025:

Particulars | 31 Mar 2024 | 31 Mar 2025 | Absolute Change | % Change

Shareholders' Funds | 6,00,000 | ?? | 3,00,000 | ??

Non-current Liabilities | 3,00,000 | ?? | NIL | ??

Current Liabilities | ?? | 3,50,000 | 1,50,000 | ??

TOTAL | ?? | ?? | ?? | ??

Non-current Assets | 7,00,000 | ?? | ?? | 50

Current Assets | ?? | ?? | ?? | ??

TOTAL | ?? | ?? | ?? | ??

OR

Prepare a Common Size Statement of Profit and Loss for the year ended March 31, 2025:

Revenue from Operations 60,00,000; Other Expenses 6,00,000; Other Income 8,00,000; ₹ ₹ ₹
Employee Benefit Expenses 12,00,000; Purchases of Stock in Trade 15,00,000; Change in ₹ ₹
Inventory (3,00,000); Tax Rate 30%.₹

3

32. (i) Give two examples of items shown under 'Short-Term Borrowings'.

(ii) Where will you disclose 'Calls-in-Arrears' in the Balance Sheet?

(iii) Where will you disclose Trademarks (an intangible asset) in the Balance Sheet?

3

33. The Current Ratio of Bright Traders is 1.5:1. State, with reasons, whether each of the following 
transactions will increase, decrease, or have no effect on the ratio:

a) Bills payable matured and paid.

b) Supplies purchased on credit.

c) Marketable securities sold at a loss.

d) A long-term loan raised and kept as cash.

OR

4



From the following information, calculate the Working Capital Turnover Ratio: Revenue from 
Operations 12,00,000; Current Assets 4,00,000; Current Liabilities 1,60,000.₹ ₹ ₹

34. Extracts of the Balance Sheets of M/s Orbit Ltd. as at March 31, 2024 and March 31, 2025, along 
with additional information, are given below. Calculate: (i) Operating Profit before changes in 
Working Capital. (ii) Cash Flows from Financing Activities.

Equity Share Capital: 20,00,000 (2025), 16,00,000 (2024). 7% Preference Share Capital: ₹ ₹
2,00,000 (2025), 3,00,000 (2024). Cash Credit: 1,50,000 (2025), 70,000 (2024). Profit and ₹ ₹ ₹ ₹

Loss (Cr.): 11,00,000 (2025), 9,00,000 (2024). 9% Debentures: 6,00,000 (2025), 5,00,000 ₹ ₹ ₹ ₹
(2024). Bank Overdraft: 90,000 (2025), 40,000 (2024). Outstanding Interest on Debentures: ₹ ₹

3,000 (2025), Nil (2024).₹

Additional Information: a) New equity shares and debentures were issued during the year. New 
debentures were issued at a 3% discount, written off at the end of the year. b) Dividend on 
preference shares (full year, on the opening balance) and an interim dividend of 8% on equity shares 
(on the opening balance) were paid during the year. c) Preference shares of 1,00,000 were ₹
redeemed during the year at a 6% premium; the premium was provided out of profits.

6

PART B — OPTION II

Computerised Accounting (Attempt Part B Option I OR Option II, not both)

27. Which chart is best suited to compare proportions of a whole?

(A) Line Chart    (B) Pie Chart    (C) Scatter Chart    (D) Area Chart

OR

A code helps in ensuring:

(A) uniqueness of each account head    (B) increased data duplication    (C) slower data retrieval    
(D) removal of all controls

1

28. Which tab is used to format the axis labels of a chart?

(A) Home

(B) Format

(C) Insert

(D) Review

1

29. Which of the following is NOT typically listed as a feature/benefit of a Computerised Accounting 
System?

(A) Speed and accuracy of processing

(B) Automatic generation of reports

(C) Continued vulnerability to human error regardless of controls in place

(D) Storage of large volumes of data

1

30. A group code is used when:

(A) codes are simply consecutive    (B) codes are divided into groups representing different 
characteristics    (C) only numbers are used    (D) no rules are followed

OR

1



Which sub-system handles fixed asset accounting?

(A) Cash sub-system    (B) Fixed Asset accounting sub-system    (C) Sales sub-system    (D) 
Purchase sub-system

31. What is verification of data, and why is it important in a Computerised Accounting System? 3

32. State three features of spreadsheet software. 3

33. State the steps to apply data validation to a range of cells in a spreadsheet.

OR

Explain the purpose of the 'Circle Invalid Data' feature in Data Validation.

4

34. What is meant by 'splitting a worksheet window'? How is it done, and why is it useful? 6



ACCOUNTANCY
Code No. 055 — Marking Scheme

MARKING SCHEME — SET 3  |  CLASS XII

PART A

Accounting for Partnership Firms and Companies

1. Salary credited increases (credits) the partner's Capital Account.  Answer: (C)

OR: Both A and R are true, and R correctly explains why no separate Current Account is needed.  
Answer: (A)

1

2. R's normal share = 2,40,000×1/6 = 40,000, less than the guaranteed 60,000. Deficiency = 20,000, 
shared P:Q 3:2 = 12,000:8,000.  Answer: (A)

1

3. At forfeiture: Share Capital Dr (5+3=8 per share)×1,200=9,600; Securities Premium Dr 
(unpaid)=2×1,200=2,400; Share Forfeited Cr=5×1,200=6,000; Allotment Receivable Cr=6,000. On 
reissue at 13 (above face value), the entire 6,000 goes to Capital Reserve.  Answer: (A) 6,000₹ ₹ ₹

OR: Called-up capital=5 (8−3 premium); received capital=3 (6−3 premium); unpaid=2. Share 
Forfeited=3×12,000=36,000. Portion for 9,000 reissued=27,000. Discount on reissue 
(10−7)×9,000=27,000, exactly absorbing the forfeited portion, leaving Nil for Capital Reserve. 
Balance remaining in Share Forfeited (for 3,000 un-reissued shares)=36,000−27,000= 9,000.  ₹
Answer: (A) 9,000₹

1

4. PC = (18,000×105)+6,00,000 = 24,90,000. Net Assets = 35,00,000−8,00,000 = 27,00,000. Since 
PC<Net Assets, Capital Reserve = 27,00,000−24,90,000 = 2,10,000.  Answer: (A)₹

OR: PC = 1,80,000+(8,000×11) = 1,80,000+88,000 = 2,68,000.  Answer: (A)₹

1

5. Arjun's portion (30% of 2,50,000=75,000 book value) at 60,000: loss 15,000. Remaining (1,75,000 
book value) at 2,00,000: gain 25,000. Net overall change = (60,000+2,00,000)−2,50,000 = +10,000 
(increase). Revaluation credited with net gain.  Answer: (A) Credited 10,000₹

1

6. Capital employed = 4,00,000+2,00,000+1,00,000 = 7,00,000. Normal Profit = 70,000. Super Profit = 
90,000−70,000 = 20,000. Goodwill = 20,000×10 = 2,00,000.  Answer: (A)₹

1

7. Period = 6 months. Interest = 60,000×6%×6/12 = 1,800.  Answer: (A)₹ 1

8. New X = 5/10+1/10 = 6/10. New Z = 1/10+3/10 = 4/10. Ratio = 6:4 = 3:2.  Answer: (A) 3:2 (closest 
matching option interpreted as 6:4)

OR: B's share=2/6=1/3. Gifted to A=1/4×1/3=1/12. Remaining 3/4×1/3=1/4, split equally A,C=1/8 
each. New A=1/2+1/12+1/8=17/24. New C=1/6+1/8=7/24. Ratio=17:7.  Answer: (A) 17:7

1

9. Realisation Account is debited only with the agreed remuneration ( 8,000).  Answer: (D)₹ 1

10. Baljit's capital = 7,50,000×2/3 = 5,00,000.  Answer: (A)₹

OR: Adjusted Disha = 4,00,000+2,50,000×3/5−1,50,000×3/5 = 4,60,000. Adjusted Esha = 
2,00,000+2,50,000×2/5−1,50,000×2/5 = 2,40,000. Total = 7,00,000. Implied total (Farah's 2,50,000 
for 20%) = 12,50,000. Hidden goodwill = 12,50,000−(7,00,000+2,50,000) = 3,00,000. Farah's share 
= 3,00,000×20% = 60,000.  Answer: (A) 60,000₹ ₹

1



11. True value = 12,00,000/1.20 = 10,00,000.  Answer: (A)₹ 1

12. Total discount = 35,000×100×5% = 1,75,000. Premium on redemption = 35,000×100×6% = 
2,10,000. Total loss = 3,85,000. Written off first against Securities Premium (3,00,000 available), 
remaining 85,000 against P&L.  Answer: (A) 3,00,000 ; 85,000₹ ₹

1

13. Existing 1,50,000 + further write-off 85,000 = 2,35,000 (Debit).  Answer: (A)₹ 1

14. Premium payable = 2,10,000, Non-Current Liability.  Answer: (A)₹ 1

15. Book value = 1,60,000+50,000+45,000+10,000+35,000 = 3,00,000. Realised = 2,70,000. Loss = 
30,000.  Answer: (A)₹

1

16. Claim (30,000) provided from the Reserve; surplus (15,000) distributed in the OLD (equal) ratio.  
Answer: (A)

1

17. Remaining for Aarav = 1−1/4(Chandan)−3/10(Bhumika) = 1−5/20−6/20 = 9/20. 
Bhumika=3/10=6/20. Chandan=1/4=5/20.

Old Aarav=3/5=12/20, Bhumika=2/5=8/20. Aarav's sacrifice=12/20−9/20=3/20. Bhumika's 
sacrifice=8/20−6/20=2/20. Sacrificing ratio=3:2.

Chandan's goodwill share=1,60,000×1/4=40,000, shared Aarav:Bhumika 3:2=24,000:16,000.

Journal: Chandan's Current A/c Dr 40,000; To Aarav's Capital A/c 24,000; To Bhumika's Capital 
A/c 16,000. New ratio=9:6:5.  [3]

OR

Old 3:2:1=30:20:10/60. New 2:2:1=24:24:12/60. Ishaan: sacrifice 6/60. Jatin: gain 4/60. Kunal: gain 
2/60.

Existing goodwill (1,20,000) written off old ratio: Ishaan 60,000; Jatin 40,000; Kunal 20,000.

Jatin's gain (4/60)×1,80,000=12,000; Kunal's gain (2/60)×1,80,000=6,000; both paid to Ishaan (the 
only partner who sacrificed), total 18,000.

Journal: (i) Ishaan's Capital Dr 60,000; Jatin's Capital Dr 40,000; Kunal's Capital Dr 20,000; To 
Goodwill 1,20,000. (ii) Jatin's Capital Dr 12,000; Kunal's Capital Dr 6,000; To Ishaan's Capital 
18,000.  [3]

3

18. Outside liabilities = 60,000+25,000 = 85,000. Partners' Loan = 40,000. Capitals = 90,000+80,000 = 
1,70,000. Total dues = 85,000+40,000+1,70,000 = 2,95,000. Realised = 3,20,000, exceeding dues by 
25,000, distributed 3:2 = Rohan 15,000; Samin 10,000, in addition to full settlement of dues.  [3]

3

19. Bank A/c Dr 14,25,000 (15,00,000×95); Discount/Loss on Issue of Debentures A/c Dr 1,65,000 
(discount 75,000+premium on redemption 90,000); To 8% Debentures Application and Allotment 
A/c 15,00,000; To Premium on Redemption of Debentures A/c 90,000.

8% Debentures Application and Allotment A/c Dr 15,00,000; To 8% Debentures A/c 15,00,000.

Securities Premium A/c Dr 1,00,000 (up to available balance); Statement of Profit and Loss Dr 
65,000; To Discount/Loss on Issue of Debentures A/c 1,65,000.  [3]

3

20. A. Investment A/c Dr 1,20,000; To Investment Fluctuation Reserve A/c 1,20,000 (loss adjusted 
against existing IFR of 2,00,000; remaining 80,000 distributed to old partners 3:2).

B. Investment A/c Dr 2,50,000, credited up to IFR balance (2,00,000) with the excess gain (50,000) 
credited directly to partners' capitals in old ratio; entire IFR (2,00,000) also distributed to partners 

3



3:2.

C. No change: entire IFR of 2,00,000 distributed to old partners 3:2 (1,20,000 and 80,000).  [3]

21. Note to Accounts — Share Capital: Authorised Capital: 2,00,000 shares of 20 each = 40,00,000.₹ ₹

Issued, Subscribed and Called-up: 90,000 shares of 20 each = 18,00,000; Less: Calls-in-arrears ₹
(Vivek, 2,500×unpaid call) adjustments, and reflecting Tanvi's forfeiture and the reissue of 3,500 of 
her shares (following the standard forfeiture-reissue procedure as illustrated in Q3), giving a net 
Share Capital figure of approximately 17,60,000.  [4]₹

4

22. Correct distribution: Interest on Capital — Ishani 50,000; Jaya 40,000; Karan 30,000. Salary — 
Ishani 60,000 (5,000×12); Karan 36,000 (9,000×4). Commission — Jaya 40,000.

Total appropriations = 50,000+40,000+30,000+60,000+36,000+40,000 = 2,56,000. Balance profit = 
3,50,000−2,56,000 = 94,000, shared 5:3:2 = 47,000:28,200:18,800.

Jaya's total = Commission40,000+Interest40,000+Profitshare28,200 = 1,08,200, well above the 
42,000 guarantee — no deficiency.

Correct totals: Ishani = 50,000+60,000+47,000 = 1,57,000. Jaya = 40,000+40,000+28,200 = 
1,08,200. Karan = 30,000+36,000+18,800 = 84,800. Total = 3,50,000 .✓

Wrongly credited (equally) = 1,16,667 each (approx). Adjustment entry: Jaya's Capital A/c Dr 8,467 
(approx); Karan's Capital A/c Dr 31,867 (approx); To Ishani's Capital A/c 40,333 (approx).  [4]

4

23. Purchase consideration = 28,00,000−10,00,000 = 18,00,000. Shares issued at 120 each = ₹
18,00,000/120 = 15,000 shares.

(i) Business Purchase: Assets A/c Dr 28,00,000; To Liabilities A/c 10,00,000; To South Peak Ltd. 
A/c 18,00,000.

(ii) South Peak Ltd. A/c Dr 18,00,000; To Equity Share Capital A/c 15,00,000; To Securities 
Premium A/c 3,00,000.

(iii) Bank A/c Dr 22,00,000 (20,000×110); To Equity Share Application and Allotment A/c 
22,00,000.

(iv) Equity Share Application and Allotment A/c Dr 22,00,000; To Equity Share Capital A/c 
20,00,000; To Securities Premium A/c 2,00,000.

Share Capital A/c: Opening 90,00,000+15,00,000+20,00,000 = Closing 1,25,00,000.₹

Securities Premium A/c: Opening 4,00,000+3,00,000+2,00,000 = Closing 9,00,000.  [6]₹

6

24. Immediate entry: Eshan's Capital A/c Dr 4,20,000; To Furniture A/c 30,000; To Eshan's Loan A/c 
3,90,000.

Eshan's Loan Account: Year 1: Opening 3,90,000, Interest@6%=23,400, Paid 
1,30,000+23,400=1,53,400, Balance 2,60,000.

Year 2: Opening 2,60,000, Interest=15,600, Paid 1,45,600, Balance 1,30,000.

Year 3: Opening 1,30,000, Interest=7,800, Paid 1,37,800, Balance Nil (closed).  [6]

6

25. Revaluation: Debit — Provision increase 4,000; Investment loss 10,000 = 14,000. Credit — Building 
appreciation (10% of 1,80,000) 18,000. Net gain = 4,000, shared 3:2 = 2,400:1,600.

Goodwill (25,000) shared 3:2 = 15,000:10,000.

Capital Accounts: Aarav = 2,00,000+2,400+15,000 = 2,17,400. Bhavya = 1,50,000+1,600+10,000 = 
1,61,600. Chirag = 1,50,000 (capital brought in).  [6]

OR

6



Revaluation: Debit — Provision @10% on 60,000 = 6,000. Credit — Building revalued 
(1,30,000−1,10,000) = 20,000. Net gain = 14,000, shared 5:3:2 = 7,000:4,200:2,800.

Existing Goodwill (30,000) written off old ratio: Manav 15,000; Naina 9,000; Omar 6,000. New 
Goodwill (60,000); Naina's share (3/10) = 18,000, contributed by Manav and Omar equally (9,000 
each).

Capital Accounts: Manav = 1,00,000+7,000−15,000−9,000 = 83,000. Naina = 
80,000+4,200−9,000+18,000 = 93,200 (transferred to Loan). Omar = 60,000+2,800−6,000−9,000 = 
47,800.  [6]

26. Simran applied for 5,000, allotted 4,000 (5:4). Application paid on 5,000 = 15,000; due on 4,000 
allotted = 12,000; excess 3,000 adjusted against allotment. Allotment due (4,000×5=20,000) less 
excess (3,000) = 17,000 unpaid — forfeited.

Forfeiture: Share Capital A/c Dr 32,000; Securities Premium A/c Dr 4,000; To Share Forfeited A/c 
15,000; To Share Allotment A/c 17,000.

Reissue: 3,000 shares at a 1.20 discount, fully paid — discount of 3,600 adjusted against Share ₹
Forfeited; remaining balance transferred to Capital Reserve.  [6]

OR

Applications 1,80,000; 20% (36,000) rejected, remaining 1,44,000 allotted pro-rata against 1,20,000 
offered (ratio 6:5). Nakul applied for 7,200, allotted 6,000; failed to pay allotment but paid within the 
stipulated notice period after the call — no forfeiture occurs. Onika (4,800 shares) paid the full 
amount due (including the call) along with allotment, recorded as Calls-in-Advance until the call is 
actually made. Standard application, allotment (with pro-rata excess adjustment), calls-in-advance, 
and call entries follow.  [6]

6

PART B — OPTION I

Analysis of Financial Statements

27. Total Closing = 28,000+75,000+55,000+1,40,000 = 2,98,000. Total Opening = 
22,000+95,000+70,000+1,05,000 = 2,92,000. Change (Opening−Closing) = 2,92,000−2,98,000 = 

(6,000).  Answer: (B)₹

1

28. Gross Profit = 25%×9,00,000 = 2,25,000. Cost of Revenue = 6,75,000. Average Inventory = 
6,75,000/6 = 1,12,500. Opening = (1,12,500×2)−1,00,000 = 1,25,000.  Answer: (A)₹

OR: The Quick Ratio is generally considered MORE reliable for immediate liquidity assessment 
(since it excludes inventory), so Assertion A is not correct as stated; R correctly explains why 
inventory is excluded.  Answer: (D) A is incorrect but R is correct.

1

29. Added back = current year's proposed dividend (2,20,000); outflow = prior year's finalised amount 
(1,60,000) less unclaimed (7,000) = 1,53,000.  Answer: (B)

OR: Tax provided = 2,40,000−2,00,000+1,90,000 = 2,30,000.  Answer: (B)₹

1

30. For a finance company, interest and dividend received on loans/investments (its core business) is an 
Operating activity.  Answer: (D)

1

31. Shareholders' Funds 2025 = 9,00,000 (50%). Non-current Liabilities 2025 = 3,00,000 (0%). Current 
Liabilities 2024 = 2,00,000 (75%).

Total 2024 = 6,00,000+3,00,000+2,00,000 = 11,00,000. Total 2025 = 9,00,000+3,00,000+3,50,000 = 

3



15,50,000 (change 4,50,000, ≈40.91%).

Non-current Assets 2025 = 7,00,000×1.50 = 10,50,000 (change 3,50,000). Current Assets 2024 = 
11,00,000−7,00,000 = 4,00,000. Current Assets 2025 = 15,50,000−10,50,000 = 5,00,000 (change 
1,00,000, 25%).  [3]

OR

Common Size Statement (% of Revenue 60,00,000): Other Income 13.33%; Total Income ₹
113.33%. Employee Benefit Expenses 20%; Purchases 25%; Change in Inventory −5%; Other 
Expenses 10%; Total Expenses 50%. Profit before Tax = 63.33% ( 38,00,000). Tax@30% = 19% ₹
( 11,40,000). Profit after Tax = 44.33% ( 26,60,000).  [3]₹ ₹

32. (i) Examples of Short-Term Borrowings: Bank Overdraft, and Cash Credit.

(ii) Calls-in-Arrears is shown as a deduction from the Subscribed (called-up) Share Capital under the 
Share Capital sub-head.

(iii) Trademarks are disclosed under Non-Current Assets, as a sub-head of Fixed Assets — 
Intangible Assets.  [3]

3

33. a) Bills payable matured and paid: both current assets (cash) and current liabilities (bills payable) 
decrease by the same amount — since the ratio (1.5:1) is above 1, the ratio INCREASES.

b) Supplies purchased on credit: current assets (stock) increase and current liabilities (creditors) 
increase by the same amount — since ratio is above 1, this DECREASES the ratio (both up equally, 
but proportionally the increase in liabilities is 'larger' relative to the existing surplus of assets over 
liabilities).

c) Marketable securities sold at a loss: cash increases by less than the book value of securities sold, 
so total current assets DECREASE slightly — ratio DECREASES.

d) Long-term loan raised and kept as cash: current assets (cash) increase; current liabilities 
unchanged (it's a non-current liability) — ratio INCREASES.  [4]

OR: Working Capital = 4,00,000−1,60,000 = 2,40,000. Working Capital Turnover Ratio = 
12,00,000/2,40,000 = 5 times.  [4]

4

34. (i) Increase in P&L = 11,00,000−9,00,000 = 2,00,000. Preference Dividend = 7%×3,00,000 = 
21,000. Interim Equity Dividend = 8%×16,00,000 = 1,28,000. Premium on Redemption = 
6%×1,00,000 = 6,000. Total appropriations = 1,55,000.

Net Profit before appropriations = 2,00,000+1,55,000 = 3,55,000.

Add back: Discount on Debentures (3%×1,00,000 new) = 3,000; Interest on Debentures 
(9%×5,00,000 opening) = 45,000.

Operating Profit before Working Capital Changes = 3,55,000+3,000+45,000 = 4,03,000.  [3]₹

(ii) Cash Flows from Financing Activities:

+ Equity Issue (20,00,000−16,00,000) = 4,00,000

+ Debenture Issue, net of discount (1,00,000−3,000) = 97,000

− Preference Redemption (1,00,000+6,000) = (1,06,000)

− Preference Dividend paid = (21,000)

− Interim Equity Dividend paid = (1,28,000)

− Interest on Debentures paid in cash (45,000−3,000) = (42,000)

+ Increase in Cash Credit (1,50,000−70,000) = 80,000

+ Increase in Bank Overdraft (90,000−40,000) = 50,000

6



Net Cash Flow from Financing Activities = 3,30,000 (inflow).  [3]₹

PART B — OPTION II

Computerised Accounting

27. A Pie Chart is best suited to compare proportions of a whole.  Answer: (B)

OR: A code ensures the uniqueness of each account head.  Answer: (A)

1

28. The Format tab is used to format axis labels of a chart.  Answer: (B) 1

29. Continued vulnerability to human error is a LIMITATION/concern, not a positive feature/benefit.  
Answer: (C)

1

30. A group code divides codes into groups representing different characteristics.  Answer: (B)

OR: The Fixed Asset accounting sub-system handles fixed asset accounting.  Answer: (B)

1

31. Verification of data is the process of checking that data already entered into the system is accurate 
and complete, typically by cross-checking against source documents. It is important because it helps 
detect and correct errors before financial reports are finalised, ensuring the reliability of accounting 
information.  [3]

3

32. Features of spreadsheet software: (i) Ability to perform automatic calculations using formulas and 
functions; (ii) Data can be represented visually using charts and graphs; (iii) Data can be sorted, 
filtered and organised easily across rows and columns.  [3]

3

33. Steps to apply data validation: (i) Select the range of cells; (ii) Go to Data > Data Validation; (iii) 
Choose the validation criteria (e.g. whole number, list, date range); (iv) Set input messages and error 
alerts as needed; (v) Click OK to apply.  [4]

OR: The 'Circle Invalid Data' feature visually marks (with a red circle/oval) any existing cell entries 
that do not meet the validation criteria set for that range, helping the user quickly identify and correct 
pre-existing invalid entries.  [4]

4

34. Splitting a worksheet window divides the window into multiple (usually two or four) separate 
scrollable panes, allowing the user to view and scroll through different parts of the same worksheet 
simultaneously. It is done via View > Split, after positioning the cursor at the desired split point. It is 
useful when comparing distant sections of a large worksheet (e.g. headers and a distant data row) 
without losing sight of either.  [6]

6


